
236� Chapter 8



Recording Your  PowerPoint Presentation	 237

Chapter 8
Recording Your  

PowerPoint Presentation

When it comes to sharing information with custom-
ers, clients, and colleagues, Microsoft PowerPoint 

has been the number one application for over a decade. 
While terrific for in-person demonstrations, PowerPoint 
does leave something to be desired when trying to pack-
age your presentation for viewing when you may not 
be there. That’s why Camtasia Studio has been so pop-
ular with PowerPoint gurus all over the world. A few 
years ago, Camtasia Studio introduced a special add-in 
module for Microsoft PowerPoint* that allowed users to 
record their presentations without ever starting up the 
Recorder. The add-in sits right in your PowerPoint tool-
bar, always at the ready, and offers much (but not all) of 
the functionality of the Camtasia Recorder.

The Camtasia Studio Add-in for PowerPoint.

*	 The instructions in this chapter are specific to PowerPoint 2010, but PowerPoint 
2003 should work similarly. The Camtasia Studio Add-in supports only PowerPoint 2003 
and the 32-bit version of 2010.
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In addition to recording the presentation window, 
this add-in can also import the recorded presentation 
directly into Camtasia Studio, complete with markers 
for each slide. These markers are automatically labeled 
using titles from the presentation, and are ideal for 
quickly setting up a table of contents for use in export-
ing to the web. Additionally, your PowerPoint notes can 
be imported for those wishing to add captions to their 
videos.

Why Record Your PowerPoint 
Presentations?
You may be thinking, “My PowerPoint presentations can 
already be viewed by other people, online or off. Why in 
the world would I want to convert them to a Camtasia 
Studio recording? That sounds like a lot of effort.” Good 
question. To answer it, let’s discuss some of the things a 
video can offer that a standard PowerPoint presentation 
cannot.

Almost as Good as Being There
For every person who attends your live presentation, 
30 or more people may end up viewing it in archived 
form. Will those people receive the same benefit when 
paging through your PowerPoint file after the fact? Will 



Recording Your PowerPoint Presentation 	 239

this presentation contain your narration, your ink com-
ments, even your face? I know that when looking over 
a PowerPoint file from a presentation I wasn’t able to 
attend, I simply couldn’t shake the feeling that I was 
viewing a “ghost” of a presentation. Yes, I had the raw 
slide data, possibly even some notes if the presenter was 
diligent. But without the presenter to guide me through 
the content, I got lost very quickly. Imagine if you could 
take the “live-ness” of your PowerPoint file and preserve 
it as part of your presentation. With Camtasia Studio, 
you can do just that.

Audio and Video
While PowerPoint does allow you to add audio narra-
tion to your slides, it does not let you use audio codecs 
to compress your narration, so a lengthy presentation 
can get quite unwieldy. Also, PowerPoint does not allow 
you to include a video of yourself. With the camera 
video options in Camtasia Studio, you can actually film 
yourself giving the presentation. This video is placed in a 
small video window, either inside the video window itself 
(picture-in-picture) or in a special side-by-side format. 
This second video stream is perfectly synched to your 
screen video. In addition to being a great supplement to 
your archived presentation, the camera video can also 
serve as a rehearsal tool. Just hit Record, practice your 
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presentation, and then you can analyze your presenta-
tion style, timing, and appearance.

Ink Annotations
One of the great features of PowerPoint has always been 
ink annotations, the ability to take your mouse and 
scribble all over your presentation to draw attention to 
certain points. This is now made even easier with the 
use of a tablet PC. The problem is that once your pre-
sentation is over, you have to either discard them or 
(provided you have a more recent version of Microsoft 
Office) save them as static drawings within your presen-
tation, thus making your slides look cluttered and ugly. 
But when you record the presentation with the Camtasia 
Recorder, the actual animation of drawing those images 
is preserved. Just as if you were there.

Portability
To view a PowerPoint presentation, you must have either 
Microsoft Office or Microsoft’s free PowerPoint player. 
Camtasia Studio allows you to avoid the issue of viewer 
software by outputting your presentation in a number 
of video formats, and easily packaging it for the web. So, 
no matter what the audience, you’ll have a way to reach 
them.
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Better Playback Control
When I open a PowerPoint file, it opens in Edit mode. I 
have to click to start the actual presentation and, depend-
ing on how it’s set up, it will either automatically take me 
through slide by slide based on timed events, or I have 
to manually click. I also have no idea how long it will 
take to view the presentation in its entirety. With most 
of the output formats offered by Camtasia Studio, how-
ever, you have handy controls as well as a view of the 
elapsed time and total running time. I can tell exactly 
where I am in the presentation, and how long I have to 
go. Plus, navigating through a very long presentation is 
a lot simpler.

Interactive Features
With the addition of Flash hotspots and quizzing, you 
can add some interactivity to a formerly flat and linear 
presentation. If you want to poll your users or test their 
knowledge about your video content, it’s pretty straight-
forward to do so with Camtasia Studio’s quizzing and 
survey features. If you want to add a button that, when 
clicked, automatically takes you to a web site, you can 
do that, too.
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Security
You may have presentations that you want to distrib-
ute, but you’d rather not have users editing your con-
tent. While PowerPoint gives you the ability to issue a 
password so that users can’t edit your file, there are util-
ity programs out there that can easily crack any Office 
password. Fortunately, Camtasia Studio allows you to 
distribute your PowerPoint slide content in a number of 
formats, none of which will allow even the most deter-
mined would-be plagiarist to mess with it.

Capture of Third-Party Applications
During your PowerPoint presentation, you might have 
cause to reference Word docs, Excel spreadsheets, or 
any number of other third-party applications and docu-
ments to help you get your point across. Camtasia Studio 
effortlessly captures all that appears on your monitor, so 
that you can distribute these segments along with your 
PowerPoint content in one cohesive package.

Camtasia Studio Add-In Toolbar
Now that we’ve talked about the why of making a video 
out of your PowerPoint presentation, let’s move on to 
the how. For this, it’s time to explore the actual toolbar:
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The Camtasia Studio Add-in for PowerPoint toolbar.

Simply launch PowerPoint, and the add-in appears in 
your toolbar palette automatically. The toolbar sports 
six buttons:

•	 Launch Presentation and Start Recording. This 
will put PowerPoint into Slide Show view and begin 
the recording process.

•	 Record Audio. If pressed, this button will record 
all sound from the microphone while the capture 
is in progress. As I’ll discuss in a minute, it can also 
be set to record any sound from the system, such 
as sound effects within PowerPoint or any prere-
corded narration embedded in the PowerPoint file. 
It is on by default.

•	 Record Camera. When clicked, this will enable the 
capture of camera video. This video data is saved 
as a separate stream inside the resulting CAMREC 
file. During editing, you can superimpose this video 
over your screen video, setting its size and position 
as desired, or place it next to your presentation in 
a side-by-side layout. Your webcamor other video 
device must be connected and the appropriate 
driver software installed in order to use this feature.
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•	 Show Camera Preview. Clicking this button will 
bring up a preview window of your camera video, 
so that you can make sure the camera is properly 
aimed, and that you stay in-frame and in-focus 
during the entire recording session. This window 
will appear on top of your presentation, but not to 
worry — it won’t be recorded. The opacity of this 
window is somewhat reduced so that you can see 
what’s underneath it while recording. As with the 
Record Camera option, it only works if you actu-
ally have a camera plugged in. Also, keep in mind 
that you can still view the camera preview even if 
you elect not to record the camera output during 
capture.

•	 Camtasia Studio recording options. This will let 
you adjust the add-in’s recording preferences. The 
details of this button and its corresponding dialog 
are discussed in the following section.

•	 Open help topic. Brings up the help topic on the 
PowerPoint add-in.

Add-In Options Dialog
The second button from the right on the toolbar is 
Camtasia Studio recording options. Clicking this button 
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brings up the Camtasia Studio Add-In Options dialog. 
This is essentially a one-screen amalgamation of all the 
effects and tools options from the Camtasia Recorder 
that are most pertinent to recording a PowerPoint 
presentation.

The dialog is divided into four sections: Program (which 
includes the Watermark options), Video and Audio, 
Picture In Picture, and Record Hotkey. Let’s look at each 
of these in turn in the following sections.

Program Options
There are six preferences in the Program section, all of 
which can be toggled on and off. They are:

•	 Start recording paused. Leaving this box checked 
will start the recording in paused mode, so that you 
can do a final sanity check prior to beginning the 
recording. It’s also handy for getting everything set 
up while people are filing into your presentation, 
and then postponing the actual recording until you 
begin to speak. This avoids having to edit out the 15 
minutes of “audience murmur” you unintentionally 
recorded before your presentation got underway.

•	 Record mouse cursor. This option, which is 
checked by default, will include the mouse cursor 
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when recording your presentation. This is a matter 
of personal taste. If you plan on using PowerPoint’s 
Pointer Options settings to do any drawing on the 
screen, I would recommend that you keep it enabled. 
If you feel that the mouse cursor will distract the 
viewer, then turn it off.

•	 Highlight cursor. If Record mouse cursor is 
enabled, then you also have the option of having 
a highlight appear around the mouse. It takes the 
form of a translucent circle that moves with the 
mouse cursor in order to help the user keep bet-
ter track of the cursor. Like the cursor highlight of 
the Camtasia Recorder, it is only seen at playback 
time, not at record time. Unlike the Recorder’s cur-
sor highlight tool, you cannot configure the cursor 
highlight to use other shapes, colors, and opacities 
— I’m afraid you’re stuck with a small, mustard-yel-
low, translucent circle. But it does get the job done.

•	 Edit in Camtasia Studio when finished. When 
checked, Camtasia Studio will automatically launch 
upon the conclusion of recording, and your saved 
project will be immediately imported, ready for edit-
ing. If unchecked, your work is saved, but Camtasia 
Studio will not open.
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•	 At end of presentation. While you can always 
stop the recording using the Ctrl+Shift-F10 hotkey 
(or some other hotkey that you specify), you can 
choose what will happen when you get to the end 
of the presentation. You can have the recording end 
automatically, continue recording, or prompt you 
about what to do.

•	 Include watermark. This option lets you add a 
watermark to your recordings. We’ll discuss this 
option in detail a bit later in its own section.

Video and Audio Options
This section of the dialog allows you to choose the set-
tings that affect how your video and audio streams are 
recorded, such as frame rate, codecs, audio source, and 
record volume.

•	 Video Frame rate. The frame rate is the number of 
frames per second at which the add-in records your 
presentation. You may either choose a frame rate 
from the drop-down list or simply type a number 
into the field. The frame rate you select will depend 
on your content. If your presentation has a gazillion 
animations like bouncing text and wacky slide tran-
sitions, you’ll want to go with a higher frame rate 
so that you can capture all these elements fluidly. 
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On the other hand, if your presentation is pretty 
static, and the only movement that happens on the 
screen is the appearance of the next slide, then you 
can easily get away with four (or even fewer) frames 
per second.

•	 Capture layered windows. With this option 
enabled, any layered windows (such as Photoshop 
palettes) can be recorded. Refer to the previous 
chapter for a full explanation of layered windows. 
They’re on by default, but since they’re unlikely to 
come up during a PowerPoint presentation, I typi-
cally leave this setting off.

•	 Record audio. Checking the Record audio box will 
include audio with your presentation, from either a 
microphone or the computer’s own system sound, 
or both at once. Just make the appropriate choice 
in the Audio source drop-down list. Note that the 
Capture system audio option is good for recording 
presentations where the audio narration has already 
been recorded within PowerPoint. However, keep 
in mind that this option might not be available to 
you if your sound card doesn’t support recording 
audio from the system (fortunately, most modern 
cards do). It may be time for an equipment upgrade 
if your sound card can’t manage this.
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The corresponding volume slider that will let you 
quickly adjust the recording volume for your selected 
audio source. You can test the volume by speaking 
into the microphone and monitoring the activity on 
the colored volume bar. Ideally, your volume should 
be within the range of yellow/orange, without going 
into the red area (where some clipping may occur). 
For the full lowdown on recording audio narration, 
please see Chapter 10, Working with Other Media: 
Audio, Camera Video, and Graphics.

•	 Advanced... button. This button brings up a dia-
log allowing you to change the default codecs and 
choose an audio recording device. Let’s take a closer 
look...

You’re presented with options for both video and 
audio. Let us first tackle the former. A click on 
the Video Setup... button will let you choose the 
video codec from a drop-down list. The default is 
the TechSmith Screen Codec 2, and I strongly rec-
ommend you leave it alone. Even if you have a ton 
of animations, TSC2 can most likely capture it all 
without dropping any frames. If you go to config-
ure the codec, you may notice here that the default 
quality  is slightly lower than it is in the Camtasia 
Recorder. I would recommend kicking it back up 
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to maximum quality, assuming you don’t drop any 
frames.

Let’s move on to the Audio Options. Click the Audio 
setup wizard... button. You’ll need to choose an 
Audio Device from the drop-down list, indicating 
which device you wish to record from (usually the 
sound card). It can be set to make use of the Windows 
default, or you can choose something different. You 
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will also see details of the chosen audio codec as well 
as that codec’s attributes on this screen. To change 
them, just click the Audio format... button.

The Audio Format dialog allows you to choose a 
Again, notice that the default is uncompressed 
(PCM), at 22.050 kHz, 16 Bit, Mono. Even though 
you’ll probably want to distribute this file on the 
web at some point, you’re going to want an uncom-
pressed master to ensure that your captures retain 
maximum quality. As such, I would actually crank 
up the bit rate to 44.1 kHz, leaving the other options 
as is. You can always compress the audio down at 
production time.

Click Next, and you’ll be able to have the wizard 
automatically set the recording volume, if desired. 
Click Finish when satisfied.

Keep in mind that if you ever lose your bearings 
when experimenting with the video and audio 
codecs, you can always go back to the factory 
defaults by clicking the Defaults button in the 
Advanced Video and Audio Setup dialog.

Picture-in-Picture Options
This section controls the implementation of camera 
video in your PowerPoint recordings. Camtasia Studio 
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offers you the ability to include a camera view of yourself. 
You can present this extra video stream either superim-
posed over your screen video or in a side-by-side forma-
tion, so that you never need to worry about the camera 
video covering up something important on your slide. 
This has exciting implications for PowerPoint. You can 
essentially hand someone a presentation you gave some 
months ago, and rather than having to decipher your 
cryptic titles and brief notes from the PowerPoint slides, 
they’re practically transported into the front row of the 
lecture hall where you delivered that presentation. They 
can view the slides, hear your voice, and see your face.

•	 Record from camera. If you’re the kind of presenter 
that stands stock-still at the podium, you can proba-
bly get away with using a simple webcam. However, 
if you’re like me and you like to move around a bit, 
it probably behooves you to recruit a volunteer to 
shoot you with a camcorder that is attached to your 
computer via IEEE 1394 (FireWire) or USB. You’ll 
end up with better, more professional footage.

To enable the camera video, click the Record from 
camera check box. Make sure that there’s actually 
some sort of video capture device attached to your 
computer; otherwise, this entire section will be 
grayed out.
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•	 Camera Setup... button. To choose a capture device 
and adjust settings, click Camera Setup... Just as 
with the Camera tab of the Tools Options dialog in 
Camtasia Recorder, the dialog that appears will let 
you pick a capture device from the drop-down list. 
As a courtesy, it also offers Camera Properties... 
and Video Format... buttons that link to the vari-
ous settings of your video device’s camera driver. 
These settings are different for every video device, 
so please consult your device’s documentation to 
learn about all the different settings.

Record Hotkey Options
This is just a quick preference setting that allows you to 
adjust the hotkey that toggles the Record/Pause and Stop 
commands. The Record toggle hotkey is Ctrl+ Shift-F9 
by default, and Stop is Ctrl+Shift-F10. You can use any 
combination of the Ctrl, Shift, and Alt modifier keys plus 
alphanumerical characters, F-keys, or the Print Screen 
key (PrtScr). The Escape key (Esc) will stop the presen-
tation and possibly the recording as well, depending on 
what you’ve chosen in the At end of presentation drop-
down list.
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Watermark Options
If you’ve watched much television in the last five years 
then you’ve probably seen a great many watermarks. 
The CBS eye and NBC peacock are examples of water-
marks.* They sit in the lower right-hand corner of the 
screen, branding the content, and you therefore have 
the constant reminder that the show you’re currently 
enjoying is broadcast into your home courtesy of them.

Do you have a corporate logo or other image you want 
to use to “brand” your video? Consider using it as a 
watermark. Just click the Include watermark check-
box (located up in the Program section of the Add-In 
Options dialog) to get things started. But we’re obvi-
ously not done yet, as we must at least choose the image 
file that will serve as our watermark. This is done by 
clicking the Watermark... button, which brings up the 
Watermark Options dialog. You’ll need to specify a file 
path of the image to use in the Image Path field. You can 
type the path into the field directly, click the drop-down 
arrow to select from the most recently used watermarks, 
or click the Browse button to maneuver through your 
directories to find the file.

*	 In the television “biz,” a watermark is called a “bug.” The software industry, however, 
avoids this terms for obvious reasons.
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There are also some preferences that can be set in the 
Watermark Options dialog. These options are a some-
what watered-down version of the Watermark dia-
log available from the Video Options screen of the 
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Camtasia Studio Production Wizard, but the basics are 
all represented.

You can do any of the following within this dialog:

•	 Select a color within the image that will be 
transparent.

•	 Change the opacity of the watermark, from fully 
transparent to fully opaque.

•	 Scale the image to an appropriate size.

•	 Choose from any of nine screen positions.

For the complete lowdown on these tools and how they 
function, please check out the more comprehensive 
discussion on watermarks in Chapter 12, The Production 
Process.

Please allow me to briefly caution you about the 
danger of using watermarks here. Adding a water-
mark with the PowerPoint add-in means that said 
watermark will be permanently “baked into” your 
footage. I tend not to use them here except in very 
rare circumstances. Using watermarks at record time 
means that you will not be able to change or remove 
them later. If you’re going to use a watermark, it’s 
far better to do so in Camtasia Studio, where you 
can always change your mind if you later decide you 
want to change it or remove it entirely.
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Recording Your Presentation
Okay, let’s get down to business. I know I’ve been build-
ing it up for about 10 pages, but the actual execution of 
a PowerPoint recording is surprisingly simple.

.

The presentation (and recording) will begin in earnest. 
Just give the presentation as you would normally, main-
taining the same pacing you’ve practiced. If you need 
to pause for any reason, you may do so by pressing the 
established hotkey (Ctrl+Shift-F9 by default). When 
paused, that small graphic box in the lower right-hand 
corner of your screen will reappear. It looks like this...
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To unpause the recording, either click the button marked 
Click to resume recording or simply hit your Record/
Pause hotkey again. If you are recording audio, be sure to 
speak loudly and clearly. You may wish to use a wireless 
lavaliere microphone so that you aren’t tethered to the 
podium. Also, do note that you might have to do some 
“creative cabling” to get your audio going to both your 
computer (for recording) and the PA system (so that 
your live audience can actually hear you). Fortunately, 
most conferences and business events have on-site tech-
nical staff who are usually happy to help. When you’ve 
finished your presentation, hit your Stop hotkey (or Esc 
if you have auto-stop set up) to stop the recording and 
return your presentation to Normal view.

If you reach the end of your presentation without first 
stopping the capture, you’ll end up with a small dialog 
that looks like this...
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You can choose at that point to stop, or keep going if 
there’s additional content you want to record. At any 
rate, once you’ve stopped the capture, a dialog appears, 
asking you for a file name and location. 

Moving Your Project to  
Camtasia Studio
After saving your file, Camtasia Studio launches (pro-
vided you didn’t turn this off in the Add-In Options dia-
log) and opens your project file. You’re also presented 
with a dialog that gives you two additional options...



Recording Your PowerPoint Presentation 	 261

So, what would you like to do?

•	 Produce your recording. By choosing this option, 
you’re essentially telling the program that you don’t 
wish to do any editing. It’s just perfect as is, and you 
want to move straight to producing your creation 
in a shareable format.

•	 Edit your recording. Since you already have your 
project open within Camtasia Studio, choosing this 
option doesn’t do much beyond clearing this dialog.

While we’re not going to tackle editing in earnest until 
the next unit of the book, there are a couple of items spe-
cific to the add-in I’m going to point out in a moment.
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Keep in mind that if you’d rather circumvent this dialog 
in the future, you can always turn it off by clearing the 
check box marked Show this dialog again. It can also 
be toggled within Camtasia Studio, on the PowerPoint 
tab of the Tools > Options... dialog. Simply uncheck 
Prompt for next action after recording is saved.

While we’ll discuss both editing and producing in later 
chapters, let us assume for now that you chose to edit 
your work. Camtasia Studio opens, and your recording 
is imported onto both the Clip Bin and the timeline.

If you have any notes in your PowerPoint presentation, 
you’ll be presented with a small dialog asking whether 
you want to import them as captions in your presenta-
tion. Captions allow hearing impaired and nonnative-
speaking individuals to enjoy your video. We’ll discuss 
captions in detail in Chapter 11.

By default, Camtasia Studio is set to always ask 
first if you’d like to import your notes as captions. 
However, if you always want to import your notes 
(or if you never do), then choose Tools > Options... 
> PowerPoint tab, and choose the appropriate option 
from the Slide Notes section.

When looking over your video project in Camtasia 
Studio, you probably noticed the presence of markers, 
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those little blue upside-down triangles that appear just 
above the Timeline. The Camtasia Studio Add-in for 
PowerPoint automatically takes the titles of these slides 
and uses them to name your markers. Why is this impor-
tant? Because when actually producing your video, you 
can use these markers to automatically create a table of 
contents for your material. The finished product will 
have an accompanying HTML file with a dynamic menu 
containing your marker names. When the user clicks 
on a menu item, the playback head goes straight to that 
point in the video.

Of course, as with any automated process, the system 
isn’t perfect. The add-in relies only on the slide’s title 
text for the marker name. People who aren’t PowerPoint 
power users can end up doing some pretty wacky things 
to get their presentation to look the way they want. It’s 
possible that the slides contain only title text (in other 
words, they used a smaller version of the title text for 
their body text). In this case, all of the slide text would 
end up in your marker name. Or, you could have the 
opposite problem, where the author used only body text 
or even no text at all (for example, when the whole slide 
is one large graphic). In this case, there will be no marker 
name whatsoever. You may also experience cases where 
the title is simply too long to make an effective menu 
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link. If you’re the one creating the PowerPoint presen-
tation, you should be cognizant of these issues if you 
know you’ll want to record it at some point. If you’re 
recording someone else’s work (hopefully with their 
permission), keep in mind that you might need to edit 
some or all of the marker names, depending on how the 
author actually created all those pretty slides. Please see 
Chapter 9, Working with Camtasia Studio, for instruc-
tions on renaming markers.

Playing Camtasia Studio 
Screencasts within PowerPoint
Up to now, we’ve talked exclusively about getting infor-
mation from PowerPoint into Camtasia Studio. But 
what if you wanted to do the reverse? Say you have a 
wonderfully set up PowerPoint presentation and, dur-
ing your presentation, you want to access some screen 
video content to show to your audience. What’s the best 
way of going about it?

If you’ve worked with PowerPoint for any length of time, 
you probably already know that PowerPoint supports 
the ability to place video content inside a slide within 
your presentation. I do not recommend this. Screen vid-
eos placed directly in the slide tend to look just awful as 
a result of PowerPoint automatically scaling the content 
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in order to fit the slide frame. Inserting a video in this 
manner works fine for real-world content, but not so 
much for screen videos. Any text in the video is ren-
dered practically illegible.

Linking to Camtasia Player
But there is a way to access videos directly within 
PowerPoint, and it has none of the aforementioned 
problems. In essence, it involves linking your presen-
tation to your external AVI video file, which will then 
open in Camtasia Player. No scaling, no yucky quality. 
Here’s a QuickCast to show you how:

Opening Camtasia Player through PowerPoint in 
this way can sometimes make the security features of 
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Microsoft Office a little grumpy. If you end up getting 
a security warning message that is disruptive to your 
presentation, you can temporarily lower PowerPoint’s 
security settings. In PowerPoint 2010, simply click the 
Enable button in the security dialog that appears.

Embedding Animated GIF Files
If you really want to embed a video into the actual pre-
sentation, there is one other option, provided the video’s 
dimensions are small and its length is short (under 20 
seconds). You can convert your video into an animated 
GIF (done within Camtasia Studio), and then import 
this image into your presentation. As a truly embedded 
part of the file, you needn’t worry about broken links 
when moving your presentation file around, and GIF 
files actually add precious little to the overall file size. 
The only hitch is that you’re confined to 256 colors. 
Check out the Quickcast on the opposite page for help 
inserting an animated GIF... 
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Troubleshooting the Add-In
What If the Add-In Doesn’t Open?
When opening PowerPoint, the Camtasia Studio Add-in 
should appear in your toolbar palette automatically. 
Emphasis on should. If it doesn’t, it could be for one 
of the reasons listed below. Fortunately, they can all be 
remedied, and I’ll explain how as we go. As these are 
listed in order from least to greatest effort required, you 
might want to try them in order.

If Camtasia Studio isn’t listed on the Add-Ins tab inside 
PowerPoint at all, you may have inadvertently disabled 
it in Camtasia Studio. From the Tools menu in Camtasia 
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Studio, choose Options... and select the PowerPoint tab. 
Make sure that Enable PowerPoint Add-in is checked, 
and then click OK. Likewise, should you ever wish to 
disable the add-in, this is the place to do it.

It’s possible you elected not to enable the add-in during 
Camtasia Studio’s installation process. Fortunately, even 
if you disable the add-in, Camtasia Studio still installs 
this capability, so no reinstallation is necessary. Again, 
simply go into Tools > Options... (PowerPoint tab) and 
enable it.

On very rare occasions, a third-party add-in designed 
for a Microsoft Office product can, through some unex-
pected turn of events, cause the application to crash. 
The next time the application is started, it will disable 
the add-in until you manually re-enable it. To see if this 
is the case, do the following:

Click the File tab and choose Options from the bottom 
of the menu. (or, in PowerPoint 2007, click the Office 
button, that circular button in the upper left-hand cor-
ner of the screen, and choose PowerPoint Options). 
Click the Add-Ins category. At the bottom of the dialog, 
under Manage, choose COM Add-Ins, and click Go... 
Check the box next to Camtasia Add-in, and click OK.



Recording Your PowerPoint Presentation 	 269

Summary
Recording PowerPoint presentations is a common use 
of the Camtasia Recorder. Its ability to better capture 
the “live” aspects of the presentation, such as audio nar-
ration, camera video, animated drawings, etc., can really 
give an extended afterlife to a presentation you’ve already 
done before an audience. With Camtasia Studio’s Flash/
HTML5 output, you can then offer additional interactive 
features such as custom navigation, clickable hotspots, 
and quizzing.
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And speaking of Camtasia Studio, the next chapter 
begins our unit on the main Camtasia Studio applica-
tion, where we take all the wonderful footage we pro-
duced in this unit, and then put it through the rigors of 
editing and production. Congratulations! You’re ready 
for the next step.
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Exercises
1.	 Without looking back at the text, try to think of at 

least five advantages video presentations have over 
PowerPoint files.

2.	 Capture a PowerPoint presentation (either this 
sample presentation or one of your own). Does it 
import your slide titles and notes text as expected? 
Any hiccups?

3.	 In the sample PowerPoint presentation linked 
above, there’s a “Play” symbol graphic on the final 
slide. Copy both the presentation and an included 
sample video from the same folder to your hard 
drive. Following the instructions in this chapter, 
set up your presentation to link to that video using 
Camtasia Player.

4.	 In your professional career, chances are you’ve had 
to give a PowerPoint presentation at some point. 
Would it be useful to preserve it as a video? If 
you’ve given a presentation recently, try archiving 
it as a video using the Camtasia Studio Add-in for 
PowerPoint.
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